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Welcome to InFOREMAX Web Portal 
InFOREMAX Web Portal is a web-based return material authorization (RMA) 

application that tracks product returns for service and manufacturing companies.  

 

InFOREMAX Web Portal allows you to file return merchandise requests on web. 

It generates a unique number for the return request and sends notification email 

to your customers and service group. The Web Portal not only provides the 

ability to view the status of return requests, add comments and update customer 

profile online, but also it helps you to ship items for the return request by 

generating shipping labels and commercial invoices. 

 

Unlike other web-based helpdesk solutions, InFOREMAX Web Portal allows your 

customers to register products online. As a result, you can manage different 

customers with their own registered products. The Web Portal also validates 

product warranty and flags warranty items whenever your customers file return 

merchandise requests online.   

 

You can deploy InFOREMAX Web Portal on a third-party webserver as a 

standalone web-based application or deploy it in-house, integrated with 

InFOREMAX RMA Software to maximize its productivity for your repair services. 

Thanks to its fully customizable html template, InFOREMAX Web Portal is fast 

and easy to deploy. 
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Requirements 
InFOREMAX Web Portal requires very little for basic operation. Your 
website is probably hosted on a Windows server. Just by uploading the 
InFOREMAX files to your website, you will surely be able to use the Web 
Portal in minutes.  
 
However, InFOREMAX is a feature-rich application. If you want to 
implement send email, you may have to install specific components on 
your server or support other server features. Use the requirements below 
for web portal deployment.  
 
Requirements for the server where you install web portal  

 A Web Server that supports ASP scripts 
 Support for one of the following databases: Access or SQL Server 
 50mb disk space  

 
Requirements for web portal management  

 Web Bowser (preferrably Internet Explorer 6 or higher) 
 FTP Client 
 An email account where you can receive web portal notifications 

 
Requirements for optional features  

 One of the email components supported by InFOREMAX (to send 
email): JMail, ServerObjectsASPMail1, ServerObjectsASPMail2, 
PersistsASPMail, CDONTS, or BambooSMTP. 

 
Skill requirements 

No special skills are required to use InFOREMAX, but you may need basic 
FTP file transfer and HTML knowledge to install the web portal, and ASP 
programming and SQL skills to customize it. 
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 Getting Started 
Before you can start using InFOREMAX Web Portal, the software must be 

installed on your server and configured. The following paragraph provides step-

by-step instructions on how to perform this task. 

Installing the Software 
Installation on a local server  

1. Unzip inforemax.zip into a folder named inforemax.  
 
2. Copy the contents of inforemax folder inside WWWRoot (the root of your 

web server) or inside your designated site folder. 
 

3. Your inforemax folder must have this structure: 
 

.  <DIR>  12-20-08 9:22p . 

..  <DIR>  12-20-08 9:22p .. 
DEFAULT ASP  301  10-11-08 12:46p default.asp 
GLOBAL ASA  634  12-02-08 12:33p global.asa 
WEBPORTAL  <DIR>  12-20-08 9:22p webportal 
INCLUDES   <DIR>  12-20-08 9:22p includes 
DATABASE  <DIR>  12-20-08 9:22p database 
BACKOFFICE <DIR>  12-20-08 9:22p backoffice 

 
4. Define full permissions on database folder and database/webportal.mdb 

file according to the operating system you are using. 
 
Windows Vista permissions  

 
a) Right click on inforemax /database folder 
b) Go to Security tab, give all permissions to IUSR account to the 

Windows directory security with Modify; Read & Execute; List Folder 
Contents; Read 

c) Enable ASP into Windows Features: Go to control panel > Programs 
and Features > Turn Windows features on or off > Internet Information 
Services > World Wide Web Services > Application Development 
Features. 
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d) Change the 'Send Errors To Browser' setting to 'True'. Go to IIS 
Manager > ASP > Debugging Properties 

 

 
 

e) Then change 'Enable Parent Paths' setting at IIS Manager > ASP > 
Behaviour 
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Windows XP permissions  

a) Disable the "Use simple file sharing" setting 
 
Within Windows Explorer [Start -> All Programs -> Accessories -> 
Windows Explorer], open the Folder Options interface [Tools -> Folder 
Options] and then go the the [View] tab and deselect the "Use simple file 
sharing" option. Select [OK] to save the change. Now you will see the 
[Security] tab within the Folder Properties interface and the [Sharing] tab 
of the root file system of a drive shows the available setting options. 
 
b) Right click on inforemax/database folder 
c) Go to Security tab, give all permissions to Anonymus Internet User 
d) Go to Sharing tab, Share the database folder 
 
Windows 2000/3 permissions  

a) Browse to the webportal.mdb file on the server 
b) Right click on the database file 
c) Click on Properties, click on Security tab 
d) Add the IUSR_MACHINENAME user to the permissions list, and grant 

this user full control (where MACHINENAME is the hostname of the 
server) 

 
Open your Web Browser and load http://localhost/inforemax/backoffice  

 
5. The first time you run BackOffice an installation Wizard will be launched. 

Follow the simple steps to complete installation. Among other settings, 
you will be asked for a password. Write down the password so you can 
login to BackOffice at a later time 
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Installation on a remote server  

1. Unzip inforemax.zip into a folder named inforemax.  
 
2. Use an FTP Client to upload the contents of the local folder to your web 

hosting space. Copy the contents of inforemax folder inside WWWRoot 
(the root of your web server) or inside your designated site folder. 
http://www.Your Domain Here.com/inforemax folder must have this 
structure: 
 

3. Your inforemax folder must have this structure: 
 

.  <DIR>  12-20-08 9:22p . 

..  <DIR>  12-20-08 9:22p .. 
DEFAULT ASP  301  10-11-08 12:46p default.asp 
GLOBAL ASA  634  12-02-08 12:33p global.asa 
WEBPORTAL  <DIR>  12-20-08 9:22p webportal 
INCLUDES   <DIR>  12-20-08 9:22p includes 
DATABASE  <DIR>  12-20-08 9:22p database 
BACKOFFICE <DIR>  12-20-08 9:22p backoffice 

 
4. Define full permissions on database folder and database/webportal.mdb 

file according to the instructions provided by your web hosting service. 
Usually, you will have a web control panel to select the folder and assign 
permissions 

 
5. Open your Web Browser and load http://www.Your Domain 

Here.com/inforemax/backoffice 
 

6. The first time you run BackOffice an installation Wizard will be launched. 
Follow the simple steps to complete installation. Among other settings, 
you will be asked for a password. Write down the password so you can 
login to BackOffice at a later time. 

 
 

 

Most installation problems are related to assigning permissions on the 
database. If you follow all steps closely, you should be able to achieve 
it.  
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Installation Wizard 
InFOREMAX contains numerous configuration options, some of which 
require a long description, so we have created an Installation Wizard with 
the most common configuration options to help you set up the web portal 
in a matter of minutes. 
 
After installation, when you try to access the web portal for the first time 
through the URL http://localhost/inforemax or http://www.Your Domain 
Here.com/inforemax you will be redirected to the Installation Wizard. 
 
Step 1 - Company Information 

The Wizard requests information on your company. The company name 
will be displayed in outgoing emails, and full company details will be 
displayed on the invoices, shipping labels and other internal pages with 
contact info. 
 
Step 2 - Regionalization  

The Wizard requests region-specific information such as date format and 
currency. The currency symbol will be displayed on all pages where prices 
are shown. The date format will be used to interpret the date received 
from the server. Contact your web hosting support or go to 
Settings/Regionalization to find out your server's date format. 
 
Step 3 - WebPortal Behaviour  
Several web Portal options are enabled or disabled: disabling registration 
of new customers (used for private stores), retrieving forgotten password 
generating (so that customers can retrieve their forgotten password via 
email), displaying custom fields, and others.  
 
Step 4 - Email Settings  

The Wizard configures settings to send email from the store. If you are not 
sure about the information required, leave NONE as the email component, 
since an incorrect configuration could produce errors during RMA request. 
We suggest you contact your web hosting support and ask: 
 
a) What email components are installed on the server? 
b) What is the SMTP URL? 
c) What POP accounts are configured for my domain? 
 
The answers will help you configure this Wizard step. 
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If you have your own server and you are unsure about email configuration, 
we suggest the following: 
a) Download the free email component Jmail from www.dimac.net 
b) Install it on your server 
c) Select Jmail at this step of the Wizard 
d) Take the SMTP mail server and email from account information as 

they are configured in your mail client (Outlook or other) 
 
Step 5 - Security  

The Wizard requests your administrator password and encryption key. 
The password will then be used to log into the Backoffice, where you will 
be able to manage your customers and RMA. Remember the user for 
login will be “admin". 
 
This step will generate an encryption key. The encryption key is a 
combination of numbers and letters. It will be used to encrypt sensitive 
data in your web portal. The string by default is a random combination. 
 

 
Did you know that…? 
If you run the installation wizard later again, a new encryption key will 
be generated. Your old key will be lost and cannot be recovered – and 
your existing users will not be able to login to the system with their 
previous password.  

 
Step 6 - RMA setting  

The Wizard requests an RMA prefix. The prefix will be used to add in the 
beginning of all automatic numbers for RMA. 
 
After completing Step 6 you will be able to access the Backoffice to load 
products, and finally test the web portal. 
 

Backoffice 
BackOffice is the basic control panel you will use to manage your web 
portal. 
 
Login 
To enter BackOffice, type in your browser the URL  
http://www.Your Domain Here.com/inforemax/backoffice, or 
http://localhost/inforemax/backoffice in the case of a local installation. 
 
Enter the user "admin" and the password you selected at step 5 of the 
Installation Wizard. 
If the information is correct, you will see a menu with options. 
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Settings Menu 
Configuration  

From this option you can modify most configurable aspects of your web 
portal. Before making a change, make sure you understand the scope of 
your actions. 
 
You should also be especially careful with the pEncryptionPassword field. 
Any modification to this setting will disable all passwords stored previously. 
 
Administrators  

From this option you can create a new users or modify an existing one. By 
default the following three roles exist in the BackOffice. 
 
Role Security Privileges 
Administrator  Full Permission 

 
Power User Read and Write Permission (excluding functions 

under settings and utilities menu.) 
 

Contributor Read and Write Permission on customer and 
RMA data only. (cannot modify products) 

 
From this section, you can also modify the password for the web portal 
administrator (admin). Make sure you use a combination of letters and 
numbers from 6 to 10 characters long. 
 
RMA Notification  

From this option you can add and edit custom message. This message 
will be included in an email notification sent to your customer whenever a 
RMA request is submitted on web. 
 
Screen Messages  

From this option you can manage all messages that appear on screen. 
Real ID is the id provided by the database. Assigned ID is one number 
assigned by the administrator. If you have a multilanguage web portal, this 
ID should be the same for the original string and the translated string. 
Then you have the file name, which is only used as a reference and the 
screen message. 
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Storefront Menu 
From this menu you can manage items and products. 
 
Products  

From this option you can add and edit products. The add product page 
prompts you to choose a product and enter its warranty period. You need 
to enter items first before you can choose a product.  Remember only the 
fields marked with an asterisk are required. Unit of Measure and 
Harmonized Tariff Code will be used in commercial invoices.  
 
Note that products cannot be deleted. If you want to exclude a product 
from the selection, you can disable it from the web portal. 
 
Items  

From this option you can add and edit items. The add item page presents 
several fields for you to fill in. Pricing information will be used in 
commercial invoices. Remember only the fields marked with an asterisk 
are required. 
 
Note that items cannot be deleted. If you want to exclude an item from the 
selection, you can disable it from the web portal. 
 
Sales Menu 
From this menu you can manage customers, RMA, reports and product 
registration. 
 
Customers  

From this option you can search customers by entering a string from their 
names or email addresses. After locating a customer you can send an 
email, modify personal information, enter a RMA, register a product, and 
disable them if you don't want them to log in the system. 
 
RMA  

From this option you can list the RMA that were submitted at the web 
portal. An RMA list is displayed first. You can click on any RMA to see 
details. 
 
At the RMA details page you can see all information on the RMA. You can 
change RMA status, enter tracking number, and leave a message for the 
return request. From this section, you can also generate shipping label, 
commercial invoice and RMA worksheet. 
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RMA Report  

From this option you can get a simple RMA report by month, including a 
chart. You will be able to view detailed statistical reports including 
RMA/product, RMA/status and RMA/month. 
 
Utilities Menu 
In this menu you will find utilities to maintain, configure and diagnose your 
web portal. 
 
Encryption  

From this option you can enter strings for encryption or decryption. It is 
especially useful to decrypt password information information. 
 
SQL Query  

From this option you can operate on the database by means of SQL 
sentences. Using this utility requires SQL knowledge, and incorrect use 
could delete important data from the database and damage the web portal. 
 
Users with SQL knowledge will find it very useful to diagnose problems, 
execute simple reports, and configure aspects of the web portal that are 
not readily manageable from Backoffice 
 
Reset Functions  

From this option you can delete all data in customer, RMA, item and 
products database. Consider the deleted data cannot be recovered. 
 
Import  

If you have an existing customers and products, you will surely prefer to 
import it rather than load all the information manually. From this option you 
can import Excel files with your customers and products. 
 
Consider File System Object must be enabled in your server, and the 
import files must be located in the BackOffice folder. 
 
The Excel templates used for importing data are present in 
the ../backoffice/excel folder. 
 
Detailed instructions for importing spreadsheet data into the database are 
available in the BackOffice 
 
Logoff 

Make sure you log off after using BackOffice so that nobody else can 
access your control panel while you are away from the computer. 
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Security Concerns 
We will provide some initial tips to secure your web portal. 
 
Database: if you are using Access you must consider that the database is 
stored in one file named webportal.mdb By default anyone can download 
the file by knowing the real location and name. 
 
What can you do to prevent this?  
1. Rename the database file and change the database folder name also 

reflecting those changes at inforemax/includes/settings.asp 
 
2. If it’s possible move the database file to some folder outside public 

access and relate the file to your store using DSN  
 

3. Add a password to the database folder so if anyone tries to download 
the file the login screen will appear  

 
4. Add a password to the database file from Access and reflect that 

change to inforemax/includes/settings.asp 
 
If you are using SQL Server just be sure that your password is not the 
default and prevent remote DB administration if possible. You may also 
check with your database vendor for regular patches to security bugs. 
 
Encrypted information: InFORMEAX Web Portal sensitive information 
using RC4 algorithm (or DES if you enable this feature). If anyone gets a 
password from the database, he will still have to decrypt that information. 
The only way to decrypt the information is with the Encryption Key located 
at settings table. We provide a random encryption setting created at 
Wizard execution. Consider that all your previous passwords and 
encrypted data will not be accessible anymore if you change the key.  
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Settings 
The file inforemax/includes/settings.asp allows you to configure the database 

location, database type and default email configuration for Error Trap script. All 

other settings are contained in settings table in the database and you can modify 

them with BackOffice. 

 

BackOffice Programs also have their own settings.asp file located in 

inforemax/backoffice/includes/settings.asp where you can configure some basic 

functions of the BackOffice (like demo mode, etc) 

StoreFront Basic Settings (inforemax/includes/settings.asp) 
By editing this file with a text editor you will be able to define an alternate 
connection string, database type or database location. You can also 
define Email Settings for Support Error script: these settings are used for 
outbound Support Error. Email configuration of Advanced Settings is not 
used for Support Error since those settings are stored into the database 
and if some error occurs, probably database will not be accessible. 

StoreFront Advanced Settings 
Using BackOffice you can browse to Settings/Configuration. From this 
option you can edit in real time all the advanced settings of the web portal 
grouped in several categories. 
 
Company Information: Company or site name and address appear on 
shipping label, commercial invoices and on most e-mail messages sent to 
customers. Here you can also specify the phone, fax, zip code, etc 
 
WebPortal Behavior 
pEncryptionPassword is the encryption string for RC4 algorithm. If you 
want to change this setting, all your previous passwords will not be 
recognized. Make sure to change the password before you logout or you 
will not be able to login again to the BackOffice if you changed the 
encryption password. 
 
pAllowNewCustomer is used to enable new customers form in login 
process; if you don’t want new customers to register just change this 
setting.  
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pForgotPassword is used to enable password notification e-mail for 
existing customers; if you don’t want customers to retrieve their password 
on web just change this setting. 

E-mail Settings 
InFOREMAX Web Portal automatically sends your customers e-mail 
messages under these circumstances: 
 

 When they submit an RMA, to confirm the RMA request. 
 When you submit an RMA request on behalf of your customers 

through BackOffice. 
 When they forget their login password, to remind them about the 

password. 
 
The e-mail settings allows you to configure: 
1. The E-Mail component is probably the most important setting in this 

section. This is what tells InFOREMAX the e-mail program that your 
Web server is using to send e-mail messages. "CDONTS" is the 
default setting. CDONTS is a script used by a large number of Web 
hosting providers to allow Web sites to send e-mail messages to their 
visitors. Check with your Web hosting provider to find out what 
application is installed on your Web server to handle e-mail 
messaging. Other popular applications (COM Objects) used for this 
purpose are: JMAIL, PersitsASPMail, ServerObjectsASPMail and 
BambooSmtp. 
 

2. Admin E-mail: This is typically the address of the person that is 
managing the web portal, or “administrator”. This address receives 
RMA notifications. 
 

3. “From” E-mail: This is the address that is used for all messages sent 
automatically from your web portal to a customer. This address 
shows up as the “From” address in the message that the customer 
receives, and it is therefore also the address that replies will be sent 
to, if the customer decides to reply to a message. 
 

4. SMTP Server. This is the send mail transfer protocol server. It can be 
a remote server also. 
 

5. Debug Email: This option is useful to determine the cause of email 
sending errors since it will display the error description on screen. 
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 RMA and Customers 
This section includes everything related to RMA and Customers such as viewing 

information about your customers, e-mailing a customer, adding a new customer 

to the database, viewing reports and charts, registering products and more. 

Viewing Customer Information 
To locate a specific customer, you can search using the customer name. 
Or you can browse all registered customers by clicking on RMA / 
Customers / List All. 
 
When you find the customer you were looking for, click on the Modify 
button to view customer details. 
 
Note that customers cannot be deleted. If you don’t want a customer to 
use the web portal, you can disable it from the web portal. 

Adding a New Customer 
By adding new customers in BackOffice you can register them in advance 
with your web portal. You can then e-mail them their user name and 
password, and a link to your web portal. 
 
When they register products or submit RMA, they will not have to register 
with the web portal, as their account has already been set up. All they will 
have to do is log in with the user name and password that you provided, 
and contact, billing, and shipping information will already be there. 
 

 

If you set up a new customer, remember to provide him/her with the 
login information that you created (user name & password). The 
customer’s e-mail address is the user name. 

 

Adding custom fields 
You can add up to three custom fields to each customer. You can use 
these fields for information like: EIN/VAT Number, customer type, etc. 
 
Instructions: 
1. Go to BackOffice/Settings/Configuration 
2. Enter the field label for CustomerFieldName1, Customer FieldName2 

and Customer FieldName3 
 



20 20

RMA Requests 
You can locate one specific RMA with the RMA number, list all RMA or list 
RMA by status. 
 
Once you have selected one RMA you can view all the details of that RMA 
such as Date, original PO number, Shipping Details, Defective Products, 
Return Reasons etc. 
 
You can also add information about the Shipping Tracking like UPS, 
USPS, FedEx tracking numbers and any other information about shipping. 
This information will be available from RMA Tracking listing to the final 
customer. Shipping Tracking can be updated using BackOffice.  
 
From Your Account menu, customers can click on RMA request link and 
fill out the form to request an RMA. When the customer submits a RMA 
request, the RMA request will be sent to the store administrator for 
approval. When the RMA is approved by the admin, the customer will be 
able to print a shipping label and commercial invoice from RMA details. 

Managing Your RMA Requests 
One of the most important functions of the RMA Display is the ability to 
change the status of the RMA. By default all RMA are stored as Submitted. 
To understand how the Manage RMA component of InFOREMAX works, 
let us first summarize how RMA are handled by your web portal. 
 
Status Id Previous Status Security Privileges 
Submitted 2 N/A At first all RMA will be saved as 

Submitted. 
In-Progress 3 2 Once you receive the defective 

product and start working on the 
repair, you may change the status 
to In-Progress. 

On-Hold 4 3  
Closed 5 4 You can also change the status of 

the RMA to Closed when you 
complete the repair and return the 
product to your customers. 

Cancel 6 2,3,4 Cancel an RMA if you receive 
invalid RMA. Cancelled RMA will 
not be considered for reports and 
charts. 
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Generating RMA Worksheet and Invoices from the BackOffice 
With BackOffice you can generate RMA Worksheet and Commercial 
Invoices based on RMA request. You will have to select one specific RMA 
and then you will be able to print the above documents in your printer 
directly from the web application. 
 
The Invoice template is located in the script 
- backoffice/rma_invoiceTemplateReturn.asp 
- webportal/rma_invoiceTemplate.asp 
 
The RMA Worksheet template is located in the script 
- backoffice/rma_worksheetTemplate.asp 
 
You can change the layout using any HTML editor. If you have BackOffice 
a bar code chart will be printed in the Invoice so you can use a Bar Code 
Reader for your accounting programs or third-party applications. 

Generating RMA Reports 
To view sales reports for your web portal, select Sales. The window that is 
displayed provides the following information: 
 

 RMA per product 
 RMA per status 
 RMA per month 

 
InFOREMAX allows you to filter per year depending on the report. Some 
reports will show charts using Java technology (included with most 
popular web browsers like IE 5.0 and above). 
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Utilities 
Utilities menu is a compilation of tools that will assist you in the day by day 

management. Here you can find a Decryption/Encryption Tool, a form to post 

SQL Queries to the database, Reset Functions to blank the database, Import 

Utilities, etc.  

Generic SQL 
This menu is one of the most important for debugging and testing. You 
can post SQL Queries such as: 
 
SELECT * FROM CUSTOMER 
DELETE FROM ITEM WHERE item_id >2 
INSERT INTO admins… 
 
You can find several guides and resources about SQL in the Internet such 
as http://www.w3schools.com/sql 

Reset Functions 
Be careful with these links. The main purpose of Reset Functions is to 
clear certain parts of the database. You can clear all RMA and customer 
records with one click. If you want to make this procedure manually it will 
get complicated since there are 3 related tables and sometimes you 
cannot delete one record if there is another related record. 

Importing data to Microsoft Excel Spreadsheets 
With this function you can import products, items, customers and 
registered products spreadsheet data into the database 
 
The Excel templates used for importing data are present in the.../ 
backoffice/excel folder. 
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Professional Databases 
Your web portal includes an Access database and a SQL script that creates 

professional database structures in a SQL Server. The following paragraph 

provides step-by-step instructions on how to create SQL database. These 

instructions assume you have a working knowledge of Microsoft© SQL Server. If 

you have any problems following these instructions please don't hesitate to 

contact technical support. 

Creating the Microsoft SQL Server Database 
1. Open SQL Enterprise Manager and Create a new database called 

"InFOREMAX". 
 
2. In SQL Enterprise Manager go to Tools>SQL Server Query Analyzer. 

On the drop down box at the top right make sure your database 
"InFOREMAX" is selected.  

 
3. Then copy and paste the contents of InforemaxWebSQL2005.txt into 

the Query Analyser. 
 

4. Click the green play button at the top. No errors appear. 
 

5. Go to Security, Login Sessions, add a user name "Inforemax" using 
database "Inforemax". Put SQL Server authentication. 

 
6. Select Users in tree view. New Database User named "Inforemax". With 

public and db_owner checked. 
 

7. Open inforemax/includes/settings.asp and change the connection to 
SQL method. Change the IP of the server (127.0.0.1 for local server) 
and change the password by the one you selected on item 5. 

 
8. Now you can open the web portal with BackOffice  
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 Appendices  

Appendix A: Customizing your web portal's graphical interface 
It is a good idea to keep the look & feel of your Web site consistent across all 

pages. This helps you convey a sense of professionalism and quality to your 

Web site visitors. For this reason, your web portal pages should appear just like 

any other page of your Web site. This section explains how to integrate your Web 

site's design with the pages generated dynamically by InFOREMAX Web Portal. 

The following paragraphs require a basic understanding of HTML. 

 

First Step: create a template. 
A template is typically a Web page that contains the main graphic and navigation 

elements that make up a Web site's interface. For example, the template on the 

right features a few graphic elements at the top, and a navigation menu on the 

left side. The page content would typically go where the "Insert Code Here" 

message is located. Web portal code would be inserted in the same area. 

When you create a template, it is a good idea to change all the navigation and 

image locations from relative (e.g. images/myimage.gif) to absolute 

(http://www.mysite.com/images/myimage.gif). This ensures that none of the links 

will be broken, regardless of the directory or subdirectory where the page may be 

located. 

 

Second Step: create "header.asp" and "footer.asp". 
Place your mouse cursor at the beginning of the section where the page content 

should appear. If you are using an HTML editor such as Macromedia® 

DreamWeaver or Microsoft® FrontPage, you can do this in the design view by 

positioning the cursor at the center of the cell that is going to contain the page 

content (i.e. web portal code, etc.). Now switch to the HTML view to display the 

code. Copy all the code from that point to the beginning of the page, paste it into 

a new Notepad file, and save it as "header.asp". Go back to the template file and 
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now copy all the code from that point to the end of the document, paste it into a 

new Notepad file, and save it as "footer.asp" 

 
Third Step: upload the files. 
Upload both files to the "inforemax/webportal/" folder on your Web server. You 

will see that sample files are already located in that folder. Rename the sample 

files before you upload your files to the server so that you can use them as a 

reference. 
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Appendix B: Database description 
 

Customer Table 

Field Name Date Type Max Length 

Customer Name* Text 100 

Job Title Text 50 

First Name Text 50 

Last Name Text 50 

Email Text 250 

Phone Number Text 30 

Fax Number Text 30 

Billing Address Text 250 

Billing City Text 50 

Billing State Text 50 

Billing Zip Text 20 

Billing Country Text 50 

Shipping Address Text 250 

Shipping City Text 50 

Shipping State Text 50 

Shipping Zip Text 20 

Shipping Country Text 50 

usrdeftext1 - 3 Text 100 
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Product Table 

Field Name Date Type Max Length 

Product Name* Text 50 

Warranty Period* Integer  

UOM Text 30 

HTC Text 50 

 

 

Item Table 

Field Name Date Type Max Length 

Part Number Text 30 

Part Name* Text 50 

Cost decimal(15, 2)  

Price decimal(15, 2)  

 

 

Customer Product Table 

Field Name Date Type Max Length 

Company Name* Text 100 

Product Name* Text 50 

Serial Number* Text 30 

Purchase Date* Date/Time  

Purchase Location* Text 50 

 


